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Electronic Case Filing System 

User’s Manual 

Getting Started         

Introduction 

This manual provides instructions on how to use the Electronic Filing System to file documents 
with the court, or to view and retrieve docket sheets and documents for all cases assigned to this 
system. Users should have a working knowledge of word processing, web browsers, file 
management and Adobe Acrobat.   

 
Help Desk 

Contact the Court’s ECF Help Desk for assistance between the hours of 8:00 a.m. - 5:00 p.m., 
Monday through Friday. 

 

Local: 612-664-5155  

Toll Free: 1-866-325-4975 

OR 

E-mail:    ecfhelpdesk@mnd.uscourts.gov 

 
Access to ECF Information and Resources  

 

For up-to-date information on ECF, visit the U.S. District Court web site at: 
www.mnd.uscourts.gov 

 

1. Click the Electronic Case Filing link (right side of home page) to: 
 

● View or download the most recent version of the ECF User’s Manual, Civil and Criminal 
Procedures Manuals 

● Self-train on a web-based ECF Tutorial 
● Practice entering pleadings into ECF using a “training” database similar to the official live 

ECF database 
● Review Frequently Asked Questions (FAQs) page 
● View CM/ECF Introductory video 

 

mailto:ecfhelpdesk@mnd.uscourts.gov
http://www.mnd.uscourts.gov/
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ECF System Capabilities 

The electronic filing system allows registered participants with Internet accounts and web 
browsing software to perform the following functions:   

 
● Electronically file pleadings and documents in actual (“live”) cases 
● View official docket sheets and documents associated with cases 
● View various reports for cases that were filed electronically 
 

Registration 

 
ECF Access  

Participants will need to register with the court to receive a login and password for the ECF 
system. Registration information is available on our web site at 
http://www.mnd.uscourts.gov/cmecf/loginfaq.shtml  (CM/ECF link >Login to CM/ECF> 
Register for ECF) 
 
Once an account has been established, the Office of the Clerk will send your login and password to 
you by regular, first-class mail or by e-mail. This information must be sent directly to the attorney 
of record and not to support staff.  Registered users can visit a training version of the system on 
the Internet at https://ecf-train.mnd.uscourts.gov  to practice ECF activities.  We strongly 
recommend that registered users practice in the “training” ECF database before filing documents 
in the “live” ECF database. 

 
Public Access to Courts Electronic (PACER) Access 

PACER is an electronic public access service that allows users to obtain case and docket 
information from Federal Appellate, District and Bankruptcy courts, and from the U.S. Party/Case 
Index.  ECF users must have a PACER account with the Court in order to use the Query and 
Report features of the ECF system.   
 
If you do not have a PACER login, contact the PACER Service Center to establish an account. You 
may call the PACER Service Center at (800) 676-6856 or (210) 301-6440 for information or to 
register for an account.  Also, you may register for PACER online at 
http://pacer.psc.uscourts.gov. 

 

PACER 
Functions 

http://www.mnd.uscourts.gov/cmecf/loginfaq.shtml
https://ecf-train.mnd.uscourts.gov/
http://pacer.psc.uscourts.gov./
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Note: Scanning is only used for documents that cannot be produced electronically.   
Scanned documents lessen the level of service we provide by slowing  

down the entire system.  We are moving away from the utilization of scanned documents 
internally and ask you to do the same whenever possible. 

 

 

Note:  If the displayed document is larger than the screen or consists of multiple  
pages, use the scroll bars to move through the document. Click the View menu  

for other options for viewing the displayed document. Choose the option that is most 
appropriate for the document. 

 

Requirements 

Hardware and Software Requirements 

The hardware and software needed to electronically file, view and retrieve case documents are the 
following: 

● A personal computer running a standard platform such as Windows or Macintosh 
● A PDF-compatible word processor like Macintosh or Windows-based versions of Corel 

WordPerfect or Microsoft Word 
● An Internet Service provider 
● A Web browser.  Internet Explorer 7.0 or 8.0 and Firefox 3.5 are recommended. Some users 

have had positive experiences with other Web browsers, but those listed here have been 
tested and certified for compatibility with CM/ECF. Mozilla Firefox is compatible with 
Mac and can be downloaded at no cost.    

● Software, such as Adobe Acrobat Writer or pdfFactory, to convert documents from a word 
processor format to portable document format (PDF). Versions of Adobe Acrobat 6 and 
later, and Acrobat Writer 5.0 adequately meet the CM/ECF filing requirements. 

● Adobe Acrobat Reader, which is available for free, is needed for viewing PDF documents 
● A scanner may be necessary to create electronic images of documents not in your word 

processing system 
 

 

 

 

Preparation 

Setting Up the Acrobat PDF Reader 

Users must set up Adobe’s Acrobat Reader software to view documents that have been 
electronically filed on the system.  When installing this product, please review and follow Adobe’s 
directions to utilize Acrobat Reader after installation. 

 
Portable Document Format (PDF) 

All documents (e.g., pleadings) must be converted to PDF or PDF/A format before being posted to 
the Court’s Electronic Case Filing (ECF) system.  Before sending the file to the court, users should 
preview the PDF formatted document to ensure it appears in its entirety and in the proper format.  
Only PDF documents may be filed using the ECF system.   

HOW TO VIEW A PDF FILE 

1. Start Adobe Acrobat program 
2. Click File menu > Open 
3. Click the location and file name of the PDF document to be viewed 
4. Adobe Acrobat Exchange loads the file and displays it on the screen 
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HOW TO CONVERT DOCUMENTS TO PDF FORMAT 

The conversion process requires special software such as Adobe Acrobat Writer or FinePrint 
pdfFactory.  Some software (e.g., WordPerfect and Microsoft Word) have Acrobat components 
built-in or available as add-ins.  These can be used to convert documents to PDF. The District 
Court of MN is not concerned with what software is used to convert the file. Options besides 
Adobe Acrobat include any features already in your word processing software, or any of the 
following: 

 

● 602Pro Print Pack 2002 ● LeadTools ePrint 3.0 

● BCL easy PDF 3.1 ● pdf995 and pdfEdit 995 

● eDocPrinter PDF Pro 5.58 ● PDF-XChange 2.5 

● eXPert PDF Printer 2.0 ● Jaws PDF Creator 3.0 

● FinePrint pdfFactory PRO 1.57 ● Win2PDF Pro 

● 602Pro Print Pack 2002 ● LeadTools ePrint 3.0 

 

Using any word processing program convert the file to PDF by: 

Once PDF conversion software is loaded on your computer: 

1. Open the document to be converted 

2. Select Print option (generally found in the File menu)  

3. Change printer option to the PDF choice available (A drop down menu with a list of 
printers is displayed) 

 

 

 

 

 

 

4. “Print” the file. The file should not actually print out; instead the option to save the file as a 
PDF format file appears (below):   
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5. Name the file, giving it the extension “.PDF” and click the Save button. 
 

 

 

 

PDF/A Documents 
PDF/A is a standard format that allows for the long-term archiving of electronic documents with 
the assurance that the documents will be accessible in the future.  CM/ECF will now accept both 
PDF and PDF/A documents. 
 

CREATING A PDF/A WITH MICROSOFT WORD 
1. To create a PDF/A directly from MS Word, the user must update the PDF conversion 

settings. In Word 2007, click on Preferences in the Acrobat menu in the ribbon:  
 

 

 

Note:  Make a note of the file location so you can find the document  
later when you are ready to post it to ECF.   

Change the location if necessary by clicking in the “Save in” area of the window. 

 

 

NOTE:  Depending on the word processing program being used, it may be 
necessary to find the printer selection option elsewhere.  At that point, change  

the printer to Adobe PDFWriter, and follow the directions above. 
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In older versions of Word, go to Adobe PDF>Change Conversion Settings to access the PDFMaker 
window. 
 
2. In the PDFMaker window, click the Create PDF/A-1a:2005 compliant file checkbox, then 

click OK.  
 

 

 

CREATING A PDF/A WITH COREL WORDPERFECT X4 
Note: Older versions of WordPerfect do not include PDF/A in the Compatibility options. 
 

1. To create a PDF/A directly from WordPerfect X4, click on File> Publish to PDF, then click 
Settings.  
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2. In the Publish to PDF Settings window, select PDF/A-1a from the Compatibility dropdown, 
then click OK.  

 

 

  

USING HYPERLINKS IN PDF/A DOCUMENTS 
To access hyperlinks in a PDF/A document, in Adobe Acrobat/Reader, go to Edit> Preferences> 
Documents, and select Never in the PDF/A View Mode dropdown list. 
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A Step-By-Step Guide 

Below is a step-by-step guide for accessing the ECF system, preparing a document for filing, filing 
a motion or application, and displaying a docket sheet.  Before actually filing for the first time, it is 
recommended to practice filing in the training database (instructions outlined in the Appendix).   

 
Log into the Live ECF System   

1. Via the Internet at: https://ecf.mnd.uscourts.gov/cgi-bin/ShowIndex.pl 

  

 

 

 

 

 

 

 

 

 

OR 

1. From the District of Minnesota’s Web site at: www.mnd.uscourts.gov 

2. Click Live ECF LINK  
 

 

 

 

 

 

 

 

3. Click U.S. District Court Minnesota – Document Filing System 

 

 

 

 

 

NOTE:  The Court Information link provides users with current  
Court and PACER Information. 

 

https://ecf.mnd.uscourts.gov/cgi-bin/ShowIndex.pl
http://www.mnd.uscourts.gov/
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The following window will appear: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Enter your ECF Login and Password in the appropriate entry fields   

If… Then… 

Filing a pleading or maintaining your account Login to ECF 

Viewing a document or using a query for case information Login to PACER** 

Login information was incorrectly entered in Click Clear, re-login 

** The PACER login provides the ability to view ECF case dockets and documents with the 
user being charged a fee.  The client code field is an optional PACER field used for organizing 

your monthly bill to associate costs to specific clients.  
 Logging into ECF with PACER login information will prohibit you from successfully 

accessing the ECF system. 

 
5. Click Login to transmit your user information to ECF 

Note:  All CM/ECF login names and passwords are case sensitive.   

NOTE:  The Live Login window for ECF will have a 
white background; the Training Database Login  

will have a teal or green-colored background  
(see Training Database section if necessary) 

 

 

 

 

 

NOTE: Notice of Redaction check box must be 
selected for successful login to CM/ECF. 
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The following security window will appear: 

 

 

 

 

 

6. Click Yes to Continue (Click “No” or “More Info” if unsure about this option)  

The Main ECF window will appear: 

 

 

 

 

 

 

 

 

 

 

 

 
NOTE:  The date you last logged into the system appears at the bottom left corner of  

this screen.  Review this information each time you login for security reasons.  If  
you believe your last login date and time are incorrect, or suspect an unauthorized  

party is using your login and password, please call the court’s  
ECF Help Desk as soon as possible. 
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Selecting ECF Features 
The following features are accessible from the Blue menu bar at the top of the main window. 

 

 

Feature Use this option to: 

Civil Electronically file all civil case pleadings, motions, and other court documents. 

Criminal 
Electronically file all criminal case pleadings, motions, and other court 
documents. 

Query 

Search by specific case number, party name, or nature of suit to retrieve 
documents that are relevant to the case.   

You must login to PACER before you can query ECF. 

Reports 
Retrieve docket sheets and cases-filed reports.  You must login to PACER 
before you can view an ECF report. 

Utilities 
View your personal ECF transaction log and maintain personal ECF account 
information. 

Search 
Use to find and get to the menu option or docket event that you need. Type in 
a partial or full word and a complete list of menus and events containing the 
word is displayed. The items appearing are links to the filing of the event.  

Logout 
Sign out of ECF and prevents any filing with your password until the next 
time you log in. Only one user can be logged in using the same 
login/password at once. 

 

See a help file for the screen you are viewing. 

 
 
Logout out of the Live System 

After you have completed all transactions for a particular session in ECF, you should exit from the 
system. 

 

1. Click Logout  

2. The main ECF login screen will reappear 
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General Information 

Registered filers will use the Civil feature of ECF to electronically self-file and docket with the 
Court a variety of pleadings and other documents for civil cases. 

 
General Rules and Manipulations 

 

CORRECTING A MISTAKE: 

Use the [Back] button on the browser toolbar to go back and correct an entry made on a 
previous screen. However, once the document is transmitted to the court, only the court can 
make changes or corrections.   

 

SIGNATURES; AFFIDAVITS OF SERVICE 

Documents, which must contain original signatures or require either verification or an 
unsworn declaration under any rule or statute, shall be filed electronically with originally 
executed copies maintained by the filer. The pleadings or other documents electronically filed 
shall indicate a signature, e.g., “s/Jane Doe.” 

 
1. The following procedure applies when a stipulation or other document (e.g., a 

joint motion, joint exhibit list, and 26(f) report) requires two or more signatures: 

a. The filer must initially confirm that the content of the document is 

acceptable to all signatories by obtaining their original signatures on the 

document. 

b. The filer then must file the document electronically, indicating the 

signatories with an “s/signature” (e.g., “s/ Jane Doe,” “s/ John Smith,” 

etc.) for each signatory. 

By filing the document, the attorney certifies that: (1) the document 

has been signed by all necessary people, including affiant and notary; 

and (2) if applicable, and the ink signed originals exist and will be 

available in their office for inspection. 1  These documents should be 

retained in accordance with the retention rules required by the Eighth 

Circuit and Federal Circuit. 

                                                      
 

1
 This procedure applies when the third party document exists on the computer of the attorney or client. If so, after 

obtaining the ink signatures on a paper copy, the filer should affix “s/” signature(s) to the word processing version, 

convert the document to PDF, and post it on ECF.  If the document is not available in electronic format, the ink signed 

paper version may be scanned and filed in ECF.  Scanning, however, is not the preferred method. 
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c. A non-filing signatory or party who disputes the authenticity of an 

electronically filed document containing multiple signatures or the 

authenticity of the signatures themselves must file an objection to the 

document within 14 days of service of the document. 
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Filing a New Civil Case (e.g., Complaint, Removal) 
The Court will accept complaints sent by e-mail, sent by U.S. Mail, or delivered in person to the 
Clerk’s Office.  The Clerk’s Office will initiate the case when all required documents and payment 
are received.  Please remember to list the case party information in the complaint. 
 

Initial Documents may be submitted by: 
 

1. Email = newcases@mnd.uscourts.gov  
2. US mail  
3. In person 

 

 
 

 

Initial Documents needed to open a new case: 
 

1. Complaint or Notice of Removal 
2. Summons 
3. Civil Cover Sheet 
4. Filing fee paid by check, cash or credit card if emailing documents indicate how payment 

will be made 
 

E-Mail 

To e-mail initiating documents you must: 

● The complaint, civil cover sheet and summons must each be separate PDF documents 

● State in the in the body of the email how the filing fee will be paid.   

- if applying for in forma pauperis (IFP) also attach the “Application to Proceed Without 
Prepayment of Fees and Affidavit” as a separate PDF to the e-mail.  

● Email address is: newcases@mnd.uscourts.gov  

● Do not email the credit card authorization form; it must be faxed to the Clerk’s Office 
   

Mailing Documents 

To mail the initiating documents follow the standard procedures the court currently has in place 
for handling initiating documents.  In the mailing include: 

● The civil coversheet and complaint 

● Indicate or include the payment (or an IFP application)  

 
Deliver Documents in Person 

To deliver initiating documents in person to the Clerk’s Office, you must bring in: 

● The civil cover sheet and the complaint 

● A check, money order or credit card in the amount of $350.00 made payable to the Clerk of 
Court 

 

 
NOTE:  The court will accept documents delivered in person on a disk/CD ROM  

or in paper format (which will be scanned by the Clerk’s Office)  

NOTE:  It is the Courts’ preference to receive initiating documents via email.  This 
compliments our continued dedication to providing excellent and timely service.   

mailto:newcases@mnd.uscourts.gov
mailto:newcases@mnd.uscourts.gov
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Summonses 

● The Clerk’s Office will receive summonses to be issued sent by e-mail, U.S. Mail, or 
delivered in person to the Clerk’s Office.  

● E-mail summonses may be sent to the e-mail address listed above along with the initiating 
case documents 

● The Clerk’s Office will sign and seal the summons. Summonses will be returned to the filer 
in paper by mail or in person. 

● A party may not electronically serve a summons, but instead must effect service according 
to the Federal Rule of Civil Procedure 4  

● Summons forms can be found on the Court’s external website 
 

 

 

NOTE:  A case will not be deemed filed until payment is received.  A Credit Card 
Authorization Form can be found on the Court’s external website: 

http://www.mnd.uscourts.gov/FORMS/ecfforms/creditcardform.pdf 

The completed Credit Card Authorization Form is to be faxed to the Clerk’s Office. 

 

 

http://www.mnd.uscourts.gov/FORMS/ecfforms/creditcardform.pdf
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Suggested Tasks to Complete Prior to Electronically Filing in ECF 

This section outlines the steps to edit or maintain certain aspects of your ECF account with the 
Court or to view a log of your transactions. 
 

Maintain Your Account – Utilities Menu 

MAINTAIN USER ACCOUNT INFORMATION 

1.  Click Utilities > Your Account > Maintain Your Account 

 

 
The following window will appear: 
 

 
 
 

 

 

 

NOTE:  This screen displays all of the registration information contained within the ECF   
database for your account with the Court. This information must be kept up to date with the 

U.S. District Court. If an attorney is linked to a law firm, the law firm address may not be 
editable.  In this case, call the ECF Helpdesk for assistance in updating your firm 

information. 
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2. Make desired changes in this window, Click Submit 

3. A confirmation window will appear, Click Submit again  
 

The following “update successful” window will appear:  

 

4. Resume ECF activities 

MORE USER INFORMATION 

This option is where the login or password may be changed. 

1. Click Utilities > Your Account > Maintain Your Account 

The Maintain User Account window will appear 

2. Click “More user information” 

The following window will appear: 

 

3. Make desired changes in this window, Click Return to Account screen, Click Submit 

4. A confirmation window will appear, Click Submit again  

The “update successful” window will appear. 

 

 

 

 

 

NOTE:  In the Password field, ECF displays a string of asterisks.  To change your ECF 
password, delete the asterisks, type a new password.  The actual characters will display 

until the new password is saved in the database. 

ECF Passwords are case-sensitive. 

If you misplace your login or password, please contact the ECF Helpdesk with your user 
name, Federal Bar ID and email address.  A new login will be sent to you upon  

confirmation of the information received. 
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EMAIL INFORMATION  

When attorneys receive a CM/ECF Account (i.e., Login and Password), they need to verify their 
email address in the system.  This is also the location to make email address changes and to add 
additional email addresses to the attorneys’ account for receipt of Notices of Electronic Filing 
(NEF). 
 

1. Click Utilities > Your Account > Maintain Your Account 

The Maintain User Account window will appear: 

 

 

 

 

 

 

 

 

 

 

 

2. Click “Email information” 

The following window will appear: 

 

  

 

 

 

 

 
3. Click “add new e-mail address”   

 
 
 
 
 
 
 
 
 

NOTE:  When an item (email link) on the left side of the window is selected, above, 
the options available and information pertaining to this item will  

appear on the right side of the window. 
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The following window will appear: 
 
 
 
 
 

 

4. Enter the Primary E-mail Address for the attorney 

5. Select Additional Options in the Configuration Options window (seen below) 
 

 

 

 

 

 

 

 

 

 
 
The Additional Options available, in the window above, are described below: 

ADDITIONAL OPTIONS WINDOW – TOP HALF 

Item Option Description  

 

A - Notices 

Should this e-mail 
address receive 
notices?  

For the primary email address, the default is Yes.  If set to No, the 
primary email address will not receive notices of electronic filing 
(NEFs)—this is not recommended.  

How should notices be 
sent to this e-mail 
address?  

Per Filing: Email sent for each individual NEF  
  
Summary Report:  One daily email listing all transactions for that 
day, sent on the following day 

 

NOTE:  If the Summary Report is selected, an additional prompt 
appears, “Should this e-mail address receive a ‘no activity’ notice 
when no summary noticing occurs?” 

 Yes, an email will be sent with the message, “no transactions 
found for this time period” when no activity occurs in the cases 
for which the user is configured to receive summary notices 

 No, unless there is case activity, no email will be generated  

A 
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ADDITIONAL OPTIONS WINDOW – TOP HALF 

ITEM OPTION  DESCRIPTION  

A – Notices 
(con’t) 

In what format should 
notices be sent to this 
e-mail address?  

Controls the format of the emails—either HTML or Text.  

  

Should this e-mail 
address receive general 
announcement notices 
from this court?  

 Yes, all court announcements will be sent to email address listed  

 No, the user will only receive general court announcement email 
messages when the court deems it essential (e.g., the message is 
urgent and must be sent to all users).  

 

 

 

 

 

 

 

 

 

 

 

ADDITIONAL OPTIONS WINDOW – BOTTOM HALF 

Item Option Description  

 
B – Case 
Specific 
Options 

Show all cases for 
this e-mail address? 

Displays a list of all of the cases for which the user is configured to 
receive NEFs.    

NOTE:  Cases appearing in this window may be copied and pasted to 
secondary email addresses. 

Add additional cases 
for noticing 

Enter specific case numbers in the text field, click Find This Case  

When desired case appears, click Add Case(s).  Case appears in the list 
of cases based on the default method of service list (the first list).  

NOTE:   

 To remove a case for this account, click on the case, click on 
Remove selected cases;   

 To change the frequency of how notices for this case are 
received, click on the case, click one of the following: Change 
selected cases to notice per filing or Change selected cases to 
notice as a summary report. 

Note: if the attorney is not an attorney of record on the case, a PACER 
fee will be incurred when viewing the document. 

B 
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6. After desired settings are made, click Return to Person Information Screen 

 

The following window will appear: 

 

 

 

 

 

 

 

 

 

 

 

 

 

7.  Click Submit, then Submit again (in the window pictured below)  
 
 
 
 
 
 
A Notice of Record Update will appear confirming changes made. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

8. Continue filing (or, see below to add additional email addresses) if desired 
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If Adding Additional E-mail Address(es): 
 
 
 
 
 
 
 
 
 
 
 
 

1. Click Add Additional E-mail Address, enter e-mail address on right-side of window 

The Configuration options window appears: 

 

 

 

 

 

 

 

 

 

 

 

2. Select desired settings in the Configuration Options window (seen above) 

 

 

 

3. When finished making changes, click “Return to Person Information Screen”  

4. Click Submit, then Submit again 

5. Continue Filing or Log out of the system 

 

 

 

NOTE:  Once the Secondary E-mail Address is entered, the same  
Additional Options are available.   
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VIEW YOUR TRANSACTION LOG  

As a free service, ECF filers may view their transaction logs.  This may be helpful to verify all 
transactions entered are reflected in the system, and that no unauthorized individuals have 
entered transactions into ECF using their logins and passwords. 
 

1. Select Utilities > Your Account > View Your Transaction Log 

 

 

 

 

 

 

 

The following window will appear: 

 

 

 

 

 
 

2. Enter the Date Parameters, Click “Run Report” 
 
 The following window will appear listing the transactions for the designated dates 

 

 

 

 

 

 

 

3. Continue Filing or Logout of ECF 
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MAILING INFORMATION FOR A CASE  

Attorneys can check ECF to see if a party is registered to receive email noticing before posting a 
filing in ECF.   
 

1. Select Utilities > Attorneys & NEFs > Mailings > Mailing Info for a Case 

 

 

 
 
 
 
 

 
The following will appear: 
 

 

 

 

 

 

 
2. Enter the Case Number, Click “Find This Case” then Click “Sumbit” 

The following window will appear listing case specific mailing information: 

 

 

 

 

 

 

 

 

 

3. Note any names listed under the “Manual Notice List”.  These attorneys need to be noticed 
in the conventional manner. 

 
4. Begin Filing or Logout of ECF. 
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Filing Documents for Civil Cases 

There are eight basic steps involved in filing a document.  These are essentially the same for each 
event filed on ECF:  

1. Select the type of document to file. 

2. Enter the case number in which the document is to be filed 

3. Designate the party(s) filing the document 

4. Specify the PDF file name and location for the document to be filed 

5. Add attachments, if any, to the document being filed 

6. Modify docket text as necessary 

7. Submit the pleading to ECF 

8. Receive notification of electronic filing (NEF) 
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Filing an Answer  

This section of the User's Manual describes the process for filing an Answer in ECF.  The process is 
similar for filing other pleadings in ECF. 

Select the appropriate menu from the ECF Menu Bar for filing: 
 

1. Click Civil > Initial Pleadings and Service > Answers to Complaints 
 
 
 
 
 
 
 
 
 
 

 
The following window will appear: 

 

 

 

 

 

 

 

2. Enter the case number, then: 
 

If… Action Then 

Number is entered correctly, 
click 

  
Click Next 

Number is entered incorrectly, 
click 

 
 

 
 

Re-enter number, click 
Find This Case 

Invalid case number message 
appears, click 

 Re-enter number, click 
Find This Case 

Multiple case numbers match 
the one entered 

Another window 
appears 

Click on the specific case 
number you are filing in,  
click Next 

 

NOTE:  This is the progression of 
windows when the correct case  

number is entered and  
“Find This Case” has been selected. 
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The following window will appear: 

 

 

 

 

 

 

 

 

 

 

 

3. Click on the filer to select the appropriate party, Click Next  
 
 

NOTE: The Case Participant Tree is for informational purposes only so the user can see all case 
participants during the process of selecting the filers and attorneys. The split-pane window 

simply provides more information in one window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Split-pane window 
 
 

Case Participant Tree 
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NOTE:  If this is the first time the attorney is filing in the case, the following  
attorney-party association window will appear.   

 

The following window will appear: 
 
 
 
 

 
 

 

 

 

 

 

 

 

(Necessary) 

4. Check the box in front of the party’s name to associate the attorney to the filing party 
 

(Optional) 

5. Check the box in front of Lead if attorney is lead attorney  
 

(Strongly Recommended) 

6. Check the box in front of Notice to receive notification when any documents are filed in 
this case. If this box is unchecked, the attorney will not receive notices of electronic filing. 

 
7. Click Next 

The following window will appear: 

 
8. Click the box next to the pleading you are answering. 
 

9. Click Next 
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The following window will appear: 

 
 

 

 

 

 

 

 

 

 

10. Click Browse, to locate the appropriate Main Document 
 
 
 
 
 

The following window will appear: 
 

 

 

 

 

 

 

 

11. Navigate to the appropriate directory and .PDF document to be filed 

12. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

 

 

 

 

 

 

 

NOTE:  It is imperative to attach an electronic copy of the actual pleading  
in step 8, above.   All documents filed in ECF MUST be in PDF format, or ECF will not 

accept the document  

 

NOTE:  It is recommended for the user to verify the correct document has been  
selected before linking it to the filing.  To do so, right-mouse click on the selected file.    

A short-cut menu will appear.  Click Open. 

 

 

 

 

 

Adobe Acrobat or Reader (or other loaded .pdf software) will open the PDF document.  
View and confirm document to be filed.  Close the .pdf program window. 

From this point forward, this informative note will not be included in the documentation. 

 

 

NOTE:  Remember to convert all documents being filed to PDF before proceeding.  
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The following window will appear:  
 

 

 

 

 

 

 

 

13. If there are no Attachments to the Answer, click Next 

14. The following window will appear: 

 
 
 
 

 

 
 

 

 
 
 

15. If there are no additional claims or complaints to the Answer, click Next 
 

 
 
 
The following window will appear: 
 

 

 

 

 

 

Note:  Counterclaim, cross-claim and third-party complaint is outlined in the 
Appendix section, “Add/Create Party for Third Party Complaint”. 
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NOTE:  Modifying docket text is optional. 
Examples may include: “First” Answer, “Amended” Answer.  

 

 

16. If there is a Jury Demand, enter Y (Yes); N (No) if not, Click Next 

 

The following window will appear: 
 

 

 

 
 
 
 

17. If necessary, click in the white Docket Text fields to edit or type additional text, Click 
Next 

 

 

 

 

 

 

 

 

 

The following window will appear: 
 

 

 

 

 

 

 

 

 

18. Confirm information in window, Click Next to submit the Answer 

 

 

 

NOTE: This is the last screen to view before submitting the pleading.  If  
corrections need to be made, click the Back button to locate the desired  

window in which changes are needed.   

To abort this filing event, click any item on the blue menu bar. 

 

 

The “Source Documents Path” is  
solely a marker to list the  

document/s attached to this  
filing event. 
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The following Notice of Electronic Filing (NEF) window will appear: 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 

NOTE: The Notice of Electronic Filing (NEF) 
confirms the completion of this filing  
event and that it has been accepted by 

the ECF system. 

This pleading is now an official court document. 

The NEF will be emailed to the addresses  
associated with this case 

 (Utilities Menu > Maintain User Account). 
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Key Reminders about the Notice of Electronic Filing: 

● It is strongly recommended to copy and save the NEF to your computer or to print and  
retain a hard copy in your files. 

● The NEF will be emailed to the attorneys and parties, associated with the case, who have 
supplied their e-mail addresses to the Court.  The NEF also displays the names and 
addresses of individuals who will not be electronically notified of the filing. 

● It is the filer’s responsibility to serve hard copies of the pleading and the Notice of 
Electronic Filing to attorneys and parties who are not set up for electronic notification.  
These names are identified in the NEF. 

● Individuals who receive the NEF via email are permitted one "free look” at the document 
by clicking on the associated hyperlinked document numbers listed in the NEF 

● Pursuant to guidelines set by the Administrative Office of the U.S. Courts, the free look is 
only available for 15 days from the date of the filing.   

● Subsequent retrieval of the case docket sheet and pleading from ECF must be made 
through your PACER account and is subject to regular PACER fees. 

● Under LR 5.4, the NEF generated by ECF constitutes a certificate of service with respect to 
those persons to whom electronic notice of filing is sent, and no separate certificate of 
service need be filed with respect to those persons.     

● If service is not made through ECF, the filing party must file a certificate of service in ECF.  
The certificate must state the manner in which service or notice was accomplished on each 
party so entitled. Filers are required to serve copies of any electronically filed pleading, 
document, or proposed order to parties not served electronically by ECF according to the 
Federal Rules of Civil Procedure. 

 

Document and Attachment Numbering  
The document selection screen was modified to include the main document number, and the 
attachments are numbered beginning with 1. This way, the attachment numbers are consistent 
everywhere they appear (e.g., docket text, the document selection screen).  
 
Also, the file sizes and the total size of all of the documents for a docket entry are displayed on the 
document selection screen when viewing a document via the docket report.  
 
The cumulative limit when viewing all or downloading all documents in a single entry is 60 MB. 

 

 

 

 

 

 

Docket 
Report 
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Filing a Motion  

This section of the User's Manual describes the process for filing a Motion in ECF.  The process is 
similar for filing other pleadings in ECF. 

 
Select the appropriate menu from the ECF Menu Bar for filing: 

1. Click Civil > Motions and Related Filings > Motions 

 

 

 

 

 

 

 

The following notification window will appear: 

 

 

2. Read through information, Click Next 

 

 

 

 

 

 

 

 

 

 

NOTE:  ECF will automatically populate the case number after the case number has 
been initially entered.   Continue filing the Motion or  

abort filing the motion by clicking on the Civil menu to restart this event. 
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3. Confirm case number, Click Next 

 

The following window will appear: 

 

 

 

 

 

 

 

 

4. Click on the type of motion being filed.  The selected event will appear on the right side of 
the window. 

5. Click Next  
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE:  Multiple motion reliefs may be filed at this time.   
To add more than one motion relief, click on another motion relief.   

To remove a selected relief, click on it in “Selected Events” box. 
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The following window will appear: 

 
 
 
 

 

 
 
 
 
 
 
 

 

6. Click on the party(s) filing the document, Click Next 
 

The following window will appear: 

 
 
 
 
 
 
 
 
 
 
 
 

7. Click Browse to locate the appropriate Main Document 

 
The following window will appear: 
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8. Navigate to the appropriate directory and file name of the PDF document to be filed 

9. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

 

 
The following window will appear: 
 
 

 

 

 

 
 
 
 
 

 

10. If there are no Attachments, click Next 
 

 
 
 
The following window will appear: 
 

 

 

 

 

 

11. If necessary, click the drop-down arrow or in the white Docket Text field to modify the 
docket text, Click Next 

The following window will appear: 

 

 

 

 

 

NOTE:  If there are attachments, Click the second Browse and link the attachment  
to the filing, select the category or enter in a document description, then Click Next. 

 

NOTE:  From this point forward, Steps 7 and 8 will only be listed; the screen shot will  
not be included. 
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12. Confirm information in window, Click Next to submit the Motion 
 

 

 

 

 

 

The following Notice of Electronic Filing window will appear: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE: The Notice of Electronic Filing (NEF) confirms the completion of this filing 
event and that is has been accepted by the ECF system.   

This pleading is now an official court document.   

This will be emailed to the addresses associated with this case:  
(Utilities Menu > Maintain User Account).  

From this point forward, this informative note will not be included in the 
documentation, and the Notice of Electronic Filing step will only be listed;  

the screen shot will not be included. 

 

 

NOTE: This is the last screen to view before submitting the pleading.  If corrections  
need to be made, click the Back button to locate the desired window in  

which to make changes.   
To abort this filing event, click any item on the blue menu bar. 

From this point forward, this informative note will not be included in the documentation. 
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Filing a Notice of Hearing on Motion  
This section of the User's Manual describes the process for filing a Notice of Hearing on Motion.   
Select the appropriate menu from the ECF Menu Bar for filing: 

1. Click Civil > Other Filings > Notices  

 

 

 

 

 

 

 

The following window will appear: 

 

 

 

 

 

 

2. Confirm case number, Click Next  

The following window will appear: 

 

 

 

 

 

 

 

 

 

 
3. Click the type of notice being filed.  It will appear on the right side of the window  

4. Click Next  
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The following window will appear: 

 

 

 

 

 

 

 

 

5. Click Browse to locate the appropriate Main Document 

 

 

6. Navigate to the appropriate directory and file name of the PDF document to be filed 

7. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

8. If there are no Attachments to the filing, click Next; if there are Attachments, attach them to 
the filing, then click Next 

 
The following window will appear: 
 
 
 
 
 
 
 
 
 

9. Click Next 

 
 
 
 
 
 
 
 
 
 
 

NOTE: This window is solely a 
reminder to file the Motion before the 

Notice of Hearing on Motion.  

 

  

 

 
NOTE: Before filing the Notice of Hearing, call chambers to get a date and time for 

the motion hearing.  

In the next step, the specifics about the Hearing are selected.   

 

NOTE:  From this point forward Step 5, above, will only be listed; screen shot  
will not be included. 
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The following window will appear: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. Enter in the Date and Time of the Hearing or Click Calendar to select date from  
pop-up Calendar menu 

 
In the same window, continue filling in fields: 
 

11. Select Location and Judge for Hearing 

12. At the bottom of the window, above, Click the box to link the Notice of Hearing on 

Motion to the Motion (filed previously), Click Next 

The following window will appear: 

 

 

 

 

13. Confirm information in window, Click Next  

14. Click Next, in the final window to submit the Notice of Hearing on Motion 
 

The Notice of Electronic Filing window will appear. 

10 

11 

12 

NOTE: If an additional Motion Hearing is 
needed, click the check box.  Another  
calendar field will appear.  Complete 
essential information then continue  

through the filing. 
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Filing a Memorandum in Support of a Motion  

This section of the User's Manual describes the process for filing a Memorandum in Support of a 
Motion.   
 
Select the appropriate menu from the ECF Menu Bar for filing: 
 

1. Click Civil > Motions and Related Filing > Supporting Documents and Responses  

 
 
 
 
 
 
 
 
 
 
 
The following window will appear: 
 

 

 

 

 
 

2. Confirm case number, Click Next  

The following window will appear: 

 

 

 

 

 

 

 

 

 

 

3. Click the type of document being filed.  It will appear on the right side of the window, 
Click Next  
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4. Click on the party(s) filing the document, Click Next 
 

5. Click Browse to locate the desired Main Document.  Navigate to and Click on the .pdf 

document to be filed.  Click Open to attach it to the filing. 

 

 

 

 

 

 

6. Click Browse to locate the Attachment/s to the Memorandum 

7. Navigate to the appropriate directory and file name of the PDF document to be filed 

8. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

9. Click the Drop-down arrow to select the Category type of document being filed 

10. Enter a description of the Attachment if necessary 

11. Repeat steps 6 - 10 as needed to attach all attachments to the filing 

12. Click Next to advance to the next window 

The following window will appear: 

 

 

 

 

 

 

13. Click the box to link the Memorandum to the related motion/s already filed, Click Next 

14.  If necessary, click in the white Docket Text field to modify the docket text, Click Next 

15. Confirm information in window, Click Next to submit the Memorandum 

The Notice of Electronic Filing window will appear. 

 

 

 

 

 

NOTE:  If there are attachments (e.g., LR 7.1 Word Count Compliance Certificate),  
they may be added in this window 

Attachments filed electronically must be less than 15MB (15,360 KB) in size 
 after being converted to .pdf. 
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Filing an Affidavit with an Attachment in Support of a Motion  

This section of the User's Manual describes the process for filing an Affidavit with an Attachment 
in Support of a Motion in ECF.   
 
Select the appropriate menu from the ECF Menu Bar for filing: 
 

1. Click Civil > Motions and Related Filings > Supporting Documents and Responses   

 

 

 

 

 

 

 

The following window will appear: 

 

 

 

 

 

 

2. Confirm case number, Click Next  

The following window will appear: 

 

 

 

 

 

 

 

 

 

 

3. Click the type of document being filed (e.g., Affidavit in Support of a Motion), Click Next  
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NOTE:  Remember to add in a clear explanation of each attachment, into the 
Description field; one that matches either the document title or label. 

4. Click on the party(s) filing the document, Click Next 

5. Click Browse to locate the appropriate Main Document 

6. Navigate to the appropriate directory and file name of the PDF document to be filed 

7. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

8. Click Browse to locate the Attachment/s to the Affidavit 

 

 

 

 

 

 

 

 

9. Navigate to the appropriate directory and file name of the PDF document to be filed 

10. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

11. Click the Drop-down arrow to select the type of document being filed 

12. Enter a description of the Attachment if necessary, i.e. Exhibit 

13. Repeat steps 8 – 12 as needed to attach all attachments to the filing 

14. Click Next 

The following window will appear: 

 

 

 

 

 

 

 

15. Enter in the Name of the Affiant, click Next 

12 
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The following window will appear: 

 

 

 

 

 

 

 
 

16. Click in the box to link the Affidavit to the related document/s already filed, Click Next 

The following window will appear: 

 

 

 

 

 

 

 

17. If necessary, click in the white Docket Text field to modify the docket text, Click Next 

18. Confirm information in window, Click Next to submit the Affidavit 

The Notice of Electronic Filing window will appear. 

 

 

 

 

 

 

 

 

 

 

NOTE:  Since its’ inception, CM/ECF has had a 30 minute time-out limit for inactivity.  When 
documents/attachments are being added to a filing, this “upload” time is considered inactive 

time by the CM/ECF Server.   
 

 In order to avoid being “timed-out” from the filing session, it is recommended to  
note the start time when uploading documents, finish that filing within 30 minutes.   

If time runs short when attaching documents (e.g., Exhibits to an Affidavit), make a note, to 
self, about which attachment was last added.  The next attachment/s to be filed for this event 

may be added in a separate event filing session (e.g., Exhibit), and then linked back to the  
previous event (e.g., Affidavit) it relates to. 

 
The maximum file size limit is 15 MB or 15,360 KB when filing in the U.S. District Court for the 

District of Minnesota With the large file size, please be mindful of the time it takes to upload 
each attachment to avoid the time-out limit.  
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Filing Exhibits  

This section of the User's Manual describes the process for filing Exhibits using the Motions and 
Related Filings menu.  If the exhibit is one PDF document, follow the steps outlined in previous 
sections to locate and open the document to attach to this event.  

Depending upon how exhibits are filed, there are three menus available in which to file exhibits 
when they are not attached to other documents or filings.   

● Motions and Related Filings > Supporting Documents and Responses  

● Other Filings > Trial Documents 

● Other Filings > Other Documents   

 

The example outlined below includes attaching more than one exhibit to the Exhibit Event.    
 

Select the appropriate menu from the ECF Menu Bar for filing: 

1. Click Civil > Motions and Related Filings > Supporting Documents and Responses   

 

 

 

 

 

 

 

2. Confirm case number, Click Next  

3. Confirm case number again, Click Next 

The following window will appear: 

 

 

 

 

 

 

 

 

 

 

4. Click the Type of Event being filed, Click Next  
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NOTE:  Remember to add in a clear explanation of each attachment, into the Description 
field; one that matches either the document title or label. 

 
To remove a document attached in error, click the Remove button, repeat steps 9 - 13. 

 

 

5. Click on the party(s) filing the document, Click Next 

6. Click Browse to locate the appropriate Main Document 

7. Navigate to the appropriate directory and file name of the PDF document to be filed 

8. Click on the file and Click Open (or double-click on the file) to attach it to the filing 
 

 

 

 

 

 

 

 

 

 

 

9. Click Browse to locate the Attachment/s to the Main Document 

10. Navigate to the appropriate directory and file name of the PDF document to be filed 

11. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

12. Click the Drop-down arrow to select the Document Category  

13. Enter a description of the Attachment if necessary 

 

 

14. Repeat steps 9 – 13 until all Attachments have been added 

15. Click Next 

NOTE: In this example screen shots will be added in to illustrate how to add two 
attachments.  The attachments are additional exhibit documents.   
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The following window will appear: 

 

 

 

 

 

 

 

 

 

16. Click the box to link the attachment to another document (event) already filed, Click Next 

 

 

 

 

 

 

The following window will appear: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

17. Click in the box(es) of the appropriate events to link the attachment(s) to, Click Next 

 

 

NOTE:  It is recommended to leave the “Filed – to” and “Documents - to” blank in  
order to generate a list of events, already filed, to link the attachment to.   

In contrast, if preferred and the dates and/or document numbers are known,  
fill in these fields, and then Click Next. 
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18. If necessary, click in the white Docket Text field to modify the docket text, Click Next 

19. Confirm information in window, Click Next to submit the Exhibit/s 

The Notice of Electronic Filing window will appear. 

 

 
NOTE:  Since its’ inception, CM/ECF has had a 30 minute time-out limit for inactivity.  When 
documents/attachments are being added to a filing, this “upload” time is considered inactive 

time by the CM/ECF Server.   
 

 In order to avoid being “timed-out” from the filing session, it is recommended to  
note the start time when uploading documents, finish that filing within 30 minutes.   

If time runs short when attaching documents (e.g., Exhibits to an Affidavit), make a note, to 
self, about which attachment was last added.  The next attachment/s to be filed for this event 

may be added in a separate event filing session (e.g., Exhibit), and then linked back to the  
previous event (e.g., Affidavit) it relates to. 

 
The maximum file size limit is 15 MB or 15,360 KB when filing in the U.S. District Court for the 

District of Minnesota With the large file size, please be mindful of the time it takes to upload 
each attachment to avoid the time-out limit.  
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Filing a Certificate of Service in Civil Cases 

Under LR 5.4, the NEF generated by ECF constitutes a certificate of service with respect to those 
persons to whom electronic notice of filing is sent, and no separate certificate of service need be 
filed with respect to those persons. 

If service is not made through ECF, the filing party must file a certificate of service in ECF.  The 
certificate must state the manner in which service or notice was accomplished on each party so 
entitled.  

Filers are required to serve copies of any electronically filed pleading, document, or proposed 
order to parties not served electronically by ECF according to the Federal Rules of Civil Procedure. 

To determine the party mailing information for a specific case, Click Utilities > Mailings > 

Mailing Info for a Case. 

Certificates of Service can either be filed as (a) an attachment in ECF during a filing or (b) a 
separate filing. When filing multiple events at the same time, a separate certificate of service can be 
filed and linked to the relevant documents as outlined below: 

 
1. Click Civil > Initial Pleadings and Services > Service of Process    

 

 
2. Confirm case number, Click Next, Confirm case number again, Click Next 

3. Click the type of document being filed, Click Next  

The following window will appear: 

 

 

 

 

 

 

 

 

 
4. Click Browse to locate the appropriate document 

5. Navigate to the appropriate directory and file name of the PDF document to be filed 

6. Click on the file and Click Open (or double-click on the file) to attach it to the filing 

7. Click Next 

8. Click on the party(s) filing the document, Click Next 

NOTE:  Because of the similarity to other events, only one screen shot will be included. 

 

NOTE:  The Note on this window indicates that if filing a 
summons-related document, rather than a certificate of 

service, return to the previous screen and select 
 Summons Returned Executed under  

the Service of Process category. 
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9. Click the box to link the attachment to another document (event) already filed, Click Next 

10. Click in the box(es) of the appropriate events to link the attachment(s) to, Click Next 

11. If necessary, click in the white Docket Text field to modify the docket text, Click Next 

12. Confirm information in window, Click Next to submit the Certificate of Service  

 
The Notice of Electronic Filing window will appear. 
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Appendix A 

Sample Attorney Registration Page 
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Appendix B 

Viewing Documents Filed in Social Security Cases & Immigration Cases 
CM/ECF will allow remote electronic public access (through PACER) to any order, opinion or 
judgment filed in a Social Security case. Previously, electronic access to documents in SSA cases 
was restricted to court users, case participants and public terminals only. This functionality reflects 
changes to Fed. R. Civ. P. 5.2(c)(2)(B), which treats these specific documents in SSA cases as 
“written opinions” for purposes of the E-Government Act of 2002.  
 
Case-level restrictions will also apply to civil cases involving immigration matters, identified with 
Nature of Suit Codes (462, 463 and 465) on the Court’s civil cover sheet.  
 
When you click the e-mail link you will be prompted for your ECF login/password. This is simply 
a security measure to ensure you have proper access to view the documents. Please review the 
screen captures below that illustrate the login process required to view documents in a social 
security case or immigration case via an e-mail notification.  
 
 

 
 

 
 
 
 
 

 
 

 
 
 
 
 
 
 

 

 
 

 

 

Click the document 
number link to view 
the document filed. 

 

NOTE:  Once you click on the link, you must enter your ECF login and password. Do not double-

click the link or the “free look” will be lost. 

NOTE:  If the “free look” has been used/is expired, login first to ECF (for identification as a case 
participant), then user will be prompted for PACER login. 
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Appendix C 

Add/Create Party for Third-Party Complaint 
 
In the Select the Party window: 

 

 

 

 

 

 

 

1. Click New Party 

The following window will appear: 

2. Enter in full or partial values for Name fields, Click Search to determine whether party 
already exists in CM/ECF 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

NOTE:  Search Tips for Locating Party Information in ECF 

a. The party database is extensive. Search the database several times before adding a new 
party. 

b. Try searching with and without punctuation 
c. Asterisks are not necessary when searching for partial names 
d. Searches: 

i. are not case sensitive  
ii. can only be performed by last name or business name 

e. Names of:  
i. Cities, counties, state agencies, etc. may be listed as “St. Paul, City of.” 

ii. Businesses and other party names may contain abbreviations 
f. If multiple matches are found, please click “select name from list” to see additional 

information regarding the party 
g. Do not enter in address information for parties  
h. Use the party text to clarify the party name. e.g., A Minnesota Corporation 
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If party is already in CM/ECF, the following window will appear: 

 

 

 

 

 

 

 

 

 

 

3. If the correct party appears, highlight the name, click Select Party (If No, skip to next page) 

The following window will appear: 

 

 

 

 

 

 

 

 

4. Modify Role if needed, i.e. Third Party Defendant 

5. Click Add Party 

The following window will appear: 

 

 

 

 

 

 

6. Select Party, Click Next, Continue filing and submit the pleading. 
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Continuation of Step 3 from previous page: 
 

3. If no, continue adding the new party  (remain on this page);  

 

 

 

 

 

 

 

 

 

 

4. Click Create New Party 

5. The following window will appear: 

 

 

 

 

 

 

 

 

 

 

6. Click Add Party 

The following window will appear: 
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NOTE:  When a new party is added, he/she is added to the Party Pick List and is  
highlighted in the list. The new party is also added to the Case Participant Tree.  

 
If the right pane of the screen does not contain the party pick list (e.g., the user 
searched for a new party but then decided not to add one), to bring the party  

pick list back to the right pane, the user should click the Pick Party button  
at the top of the screen. 

 
To add more parties, repeat Steps above.  

 
 

 

 

 

 

 

 

 

 

7. Select Party, Click Next, Continue filing and submit the pleading. 
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Definition of Controls 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Control Description 

 
Edit Participant Record 

 Delete Participant Record 

 Add Alias to Participant Record 

 **Court Use Only** 

 
 

NOTE:  If a new participant is added during the docketing process, icon 
controls will only be available for that new participant.  The controls are 

further explained below. 
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NOTE:  The ECF system does not permit you to change the misfiled document(s) or incorrect  
docket entry after the transaction has been accepted. 

Appendix D 

Additional Information Regarding ECF  
 

SELECTING FILERS IN A LARGE CASE (CIVIL ONLY)  
When a civil case has a large number of participants, the participants are sorted in alphabetical 
order by last name, and are grouped into chapters. Each chapter is displayed in the participant 
tree as a hyperlink. If the user clicks a chapter hyperlink, the participants in the chapter are listed 
in the tree 

 
 

COMMON ERRORS WITH ECF FILING 
If the ECF system does not recognize your login and password, it will display the following error 
message on a new screen. 

Login failed either your login name or key is incorrect 

Click on the [Back] button in your browser and re-enter your correct login and password. 
If you cannot access the ECF system using your assigned login and password, please call the 
helpdesk at 1-866-325-4975 

 

 

DOCUMENTS FILED IN ERROR  
A document incorrectly filed in a case may result from: a) attaching the wrong PDF file to a docket 
entry; b) entering the wrong case number and not discovering the error before completing the 
transaction; or c) selecting the wrong document type from the menu. 
 

 
POSTING THE WRONG PDF FILE TO A DOCKET ENTRY OR ENTERING THE 
WRONG CASE NUMBER 
Generally, the U.S. District Court of Minnesota will be leaving incorrectly filed documents, in the 
correct case, on the ECF system. If the document was filed in the incorrect case and needs to be 
moved to the correct case, please use the phone number below to request a correction: 
 

Local 612-664-5155 

Toll Free 1-866-325-4975 

 
1. Please make the call as soon as possible after an error is discovered.   

2. Provide the case and document numbers for the document requiring correction.  

3. If appropriate, the court will make an entry indicating that the document was filed in error. 

You will be advised if you need to re-file the document.   
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NOTE:  For moderate length paper attachments, consider dividing them into two or more smaller 
attachments, scanning, and filing them electronically. 

. 

SELECTING THE WRONG DOCUMENT TYPE 
In the event you selected and highlighted a file that is not in PDF format, ECF will display the 
following error message after you click on the [Next] button. 

 
 
 
 
 
 
 
 
 
 

1. ECF will not permit you to select a file for your pleading that is not in PDF format. 

2. Click on the [Back] button and ECF will return to the Answers to Complaints screen.  

3. Select and highlight the PDF file of your pleading and proceed as before. 

 

FAILURE TO SELECT A DOCUMENT TO FILE 
If you fail to select a document to file with your pleading, ECF will display the error message 
depicted below. 

 

 

 

 

 

If you click [OK] from the screen depicted above ECF will return you to the Attachments screen.  
You cannot proceed without attaching a PDF document. 

 

Attachments And Attachment Size  
Attachments electronically filed must be less than 15MB or 15, 360 KB after the document has been 
converted to PDF. 
 
Attorneys may seek leave of the court to file conventionally if attachments and exhibits are 
voluminous.  Refer to the Civil Procedures guide for more details on this matter.   
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LOGGING OUT OF CM/ECF 
When you click Logout from the main blue menu bar, the following pop-up message will appear: 

 

 

PACER WINDOW 
When PACER is needed to access and/or print documentation, a “Transaction Receipt” table 
appears at the bottom of the current window.  As seen below, this table provides the total charges 
billed at the present time. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

COMMON ERRORS WITH SEALED DOCUMENTS 
For more details about filing under seal, please refer to the Civil Procedures guide, Section IX, part 
D.   
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Appendix E 

The Federal Rules and Personal Identifiers 
 

Under Fed. R. Civ. P. 5.2(a), unless the court orders otherwise, an electronic or paper filing with 
the court that contains an individual’s social-security number, taxpayer-identification number, or 
birth date, the name of an individual known to be a minor, or a financial-account number, the 
filing party or nonparty  may include only: 
 

a. The last four digits of the social-security number and taxpayer-identification 
number; 

b. The year of the individual’s birth; 

c. The minor’s initials; and 

d.  The last four digits of the financial-account number. 

In addition, exercise caution when filing documents that contain the following: 

a. Personal Identifying Number (e.g., driver’s license number); 

b. Medical Records, Treatment and Diagnosis; 

c. Employment History; 

d. Individual Financial Information; 

e. Proprietary or Trade Secret Information. 

Under Fed. R. Civ. P. 5.2(b), the redaction requirements do not apply to the following:  

a. A financial-account number that identifies the property allegedly subject to 
forfeiture in a forfeiture proceeding; 

b. The record of an administrative or agency proceeding; 

c. The official record of a state-court proceeding; 

d. The record of a court or tribunal, if that record was not subject to the redaction 
requirement when originally filed; 

 
e. A filing covered by Rule 5.2(c) or(d) ; and  

f. A pro se filing in an action brought under 28 U.S. C. §§ 2241, 2254, or 2255. 

WAIVER OF PROTECTION OF IDENTIFIERS   

A person waives the protection of Rule 5.2(a) as to the person’s own information by filing it 
without redaction and not under seal.  Fed. R. Civ. P. 5.2(h). 

ENFORCEMENT 

It is the sole responsibility of counsel and the parties to be sure that all pleadings comply with the 
rules of this court requiring redaction of personal data identifiers.  The Clerk will not screen 
documents for redaction and will not reject documents solely on the basis that the documents 
contain personal identifiers. 
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FILING UNREDACTED DOCUMENTS UNDER SEAL 

1. Under Fed. R. Civ. P. 5.2(f)-(g), a person making a redacted filing may also file:  

a. An unredacted copy of the document under seal without seeking leave of the court 
in accordance with Section IX.D. regarding filing documents under seal; or 

b. A reference list under seal without seeking leave of the court in accordance with 
Section IX.D. regarding filing documents under seal.  The reference list must 
contain the complete personal data identifier(s) and the redacted identifier(s) used 
in its place in the filing. 

 
2. The redacted version of the document must be filed in ECF with a conventional filing 

placeholder as an attachment indicating the existence of the sealed document on the record.   
A sample conventional filing placeholder is available from the clerk or from the court’s 
website  at www.mnd.uscourts.gov,  under the “Court Forms” tab. 

 
3. The Notice of Electronic Filing (NEF) and the conventional filing placeholder for the 

redacted version must be attached to the envelope of the sealed version or list. 
 

4. File the sealed version or list in accordance with Section IX.D. 

 
5. The unredacted version and/or reference list must be retained by the court as part of the 

record. 
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Sample of Personal Data Identifiers Redacted Document 
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Appendix G  

Creating an Appendix with Document Links 
 
A set of radio button options labeled Include documents in Appendix and Include document 
hyperlinks in Appendix appear at the bottom of the Docket Report. These options allow users to 
indicate if the PDF documents they selected for inclusion in the appendix docket sheet should be 
appended to the docket sheet or if hyperlinks to those documents should be included instead. 
 

OPTIONS FOR CREATING AN APPENDIX 
When the Docket Report is run with the Create Appendix option selected, two radio buttons are 
included at the bottom of the report: Include documents in Appendix and Include document 
hyperlinks in Appendix.  
 

   

 

CREATING AN APPENDIX WITH THE “INCLUDE DOCUMENTS IN APPENDIX” 
OPTION 
If the Include documents in Appendix option is selected when the appendix is generated, the 
application produces a PDF version of the docket sheet with the selected documents appended.  
 

CREATING AN APPENDIX WITH THE “INCLUDE DOCUMENT HYPERLINKS IN 
APPENDIX” OPTION 
If the Include document hyperlinks in Appendix option is selected when the appendix is generated, 
the application produces a PDF version of the docket sheet that does not include the documents 
from the case record.  
 
Instead, this PDF includes document hyperlinks which direct the user clicking on them back to the 
District court’s CM/ECF application to view the document(s). 
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Sample Appendix PDF with Document Hyperlinks: 
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Appendix H 
 

Accessing the ECF Training Database  
 

1. From the District of Minnesota’s Web site at: www.mnd.uscourts.gov 

2. Click CM/ECF > Login To CM/ECF  

3. Click the “Login Into ECF Training Database” link 

 

  

4. Click U.S. District Court of Minnesota – Training System link 

 

 

 

 

 

 

 

 

5. Login using the Attorney Training Login and Passwords  (listed on the page in step 4 

above)  

 

http://www.mnd.uscourts.gov/

